
 

 

 

SESSION 2 
Postcards from the Edge 
In this session, students send a postcard to a friend asking them to become 

involved in protecting Earth. To prepare for this task, they are introduced to 

Microsoft Publisher. Once familiar with the parts of the window, a template is 

opened in the program. Students learn how to draw and format a shape to 

create a background for the front of the postcard. Next, they include a 

catchy title using a text box. To attract attention to the issue, a picture 

illustrating damage to the environment is inserted with a caption. A message is 

then written on the back with the address of the recipient included on the 

postcard.  

 

I wish you were here to help solve this problem! 

 

Assignment 5: About Microsoft Publisher 

Assignment 6: Design the Front of the Postcard 

Assignment 7: Design the Back of the Postcard 

 

Session 2 Review: About Microsoft Publisher 

Session 2 Skill Review: The World is Not Your Trash Can! 

Session 2 Extension Activity: Environmental Map 
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Session 2: Postcards from the Edge 

Getting Started 

Overview 

In this session, students send a postcard to a friend asking them to become involved in 

protecting Earth. To prepare for this task, they are introduced to Microsoft Publisher. Once 

familiar with the parts of the window, a template is opened in the program. Students learn how 

to draw and format a shape to create a background for the front of the postcard. Next, they 

include a catchy title using a text box. To attract attention to the issue, a picture illustrating 

damage to the environment is inserted with a caption. A message is then written on the back 

with the address of the recipient included on the postcard.  
 

Materials 

 Microsoft Publisher 

 Microsoft Publisher Flashcards (Optional) 

File Tab Drawing Tools Format Tab Picture Tools Format Tab 

Home Tab Text Box Tools Format Tab  

 Environment Folder 

o postcard template 

o postcard sample file 

o Fact Sheets 

 Research sheet created in Session 1 / Pictures saved in Session 1 

 Postcard Checklist located in the Assessment Tools folder (Optional) 

 Postcard Marking Sheet located in the Assessment Tools folder (Optional) 

 Session 2 Review: About Microsoft Publisher (Optional)  

 Session 2 Skill Review: The World is Not Your Trash Can! (Optional) 

o postcard template 

o Garbage folder 

o Garbage Postcard sample file 
 

Teacher Preparation 

(Refer to the Preparing to Teach section of this guide for instructions) 

 Make the Environment folder available to students.  

 (Optional) Print the flashcards listed in the materials list for this session.  

 

Teaching Strategy 

In this session, students make a postcard to encourage others to become involved in the 

environmental issue that they have chosen to research. Explain scenario to students: 
 

In order for people to become interested in an environmental issue and 

help to implement solutions, they must first be aware of the problem. As a 

responsible environmental steward, you create a postcard in this session to 

raise awareness of the issue you have chosen. You will include information 

and a picture that you researched in the previous session. Send the 

postcard to fellow students to spread the word about conserving our natural resources. 
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Assignment 5 About Microsoft Publisher 
 

In this assignment, students are introduced to the parts of the Microsoft Publisher window. 

Students label a diagram of the window. They explore the commands and then answer 

questions about the tabs on the ribbon.  

 

Assignment 6 Design the Front of the Postcard 
 

In this assignment, learn how to insert and format shapes, text boxes, and pictures using 

commands in Microsoft Publisher by designing the front of a postcard. To prepare for the task, 

students open a sample postcard about acid rain and answer questions about the content. 

Once they are familiar with the expectations, students open the postcard template. They begin 

by learning how to format a shape using commands on the Drawing Tools Format tab to create 

a background. Next, they draw a text box and customize the appearance using commands on 

the Text Box Tools Format tab. Afterwards they insert a picture of the environmental issue and 

adjust the appearance using commands on the Picture Tools Format tab. A caption that 

explains the environmental problem is then applied to the picture and formatted using skills 

acquired throughout the assignment. 

 

Assignment 7 Design the Back of the Postcard 
 

In this assignment, students complete the postcard by adding a message and an address on the 

back. On the left side of the postcard, students explain the environmental issue. On the right side 

of the postcard, the address of the recipient is written. 
 

Tips: 

 Obtain Research Sheet: Before beginning, ensure that each student has a printed copy 

of the research sheet created in Session 1. Students use information from the Causes and 

Effects sections to write facts in the message on the postcard. 

 Decide upon the Recipient: The postcard must be addressed to someone. Consider first 

what you plan to do with the completed postcards. You can do one or more of the 

following: 

o Deliver postcards to other students in the class or to another class in the school 

o Mail postcards to another school 

o Post postcards on a bulletin board under the heading Save Earth, Learn to 

Conserve, Wish You Were Here to Help, or Postcards from the Edge. 

 Write down the Address: Have addresses available for the students to write onto their 

postcards. You may wish to write them on the blackboard or whiteboard or post them 

where students can read them as they create their postcards. Alternatively, students can 

make up a fictional address. 

 Decide the Purpose of the Postcard: When printing, students choose Side-fold, half sheet. 

This prints two copies of the postcard on one sheet. The cards are cut apart and then 

taped or glued with the two blank sides of the postcard together. Instruct students what 

they should do with the extra card: 

o Deliver one copy and keep the other one 

o Submit it for evaluation  

o Post it on a bulletin board display  

o Keep it to take home to spread the environmental message to family and friends 

 

 
Please note: There is a marking sheet for the completed postcard in the Assessment Tools folder. 
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Lesson Plan 

Assignment 5 - About Microsoft Publisher 

 Read about the features of Microsoft Publisher. 

 Open Microsoft Publisher. 

 Explore the Publisher window and label a diagram of the parts. 

 Answer questions about commands and tabs on the ribbon. 

 Close Microsoft Publisher. 

 

Assignment 6 - Design the Front of the Postcard 

 Examine a sample postcard to preview the elements on the front and back. 

 Answer questions about the content and design of the sample postcard. 

 Open the postcard template in Microsoft Publisher. 

 Create the background of the postcard: 

o Draw and format a shape using commands on the Drawing Tools Format tab: 

select a style, fill the shape, select an outline, change the shape, apply a 

shadow, and align the shape. 

 Write a title that attracts attention to the environmental issue: 

o Draw a text box. 

o Format the text using commands on the Text Box Tools Format tab: adjust the fit 

and direction, format the font, align the text, and add effects to the text. 

o Format the text box using the Text Box Tools Format tab and the Drawing Tools 

Format tab. 

 Include a picture that raises awareness of the environment issue: 

o Insert a picture. 

o Resize and move the picture. 

o Format the picture using commands on the Picture Tools Format tab: select a 

style, change the border, change the shape, and add a caption. 

 Use skills to complete the front of the postcard. 

 Save the postcard and exit Microsoft Publisher. 

 

Assignment 7 - Design the Back of the Postcard 

 Open the saved postcard in Microsoft Publisher. 

 Move to Page 2 using the page navigation pane. 

 Draw a text box on the left half of the back of the postcard. 

 Write the message to the recipient about the environmental issue. 

 Add an address in a text box on the right half of the back of the postcard. 

 Complete the checklist. 

 Print two postcards on one page, cut apart, and fasten back to front of card. 

 Save the postcard and exit Microsoft Publisher. 
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Learning Objectives 

Students should be able to complete each learning objective independently. 
 

Content Knowledge: 

 label the parts of the Microsoft Publisher window including the title bar, quick access toolbar, 

window controls, ruler, ribbon, group, command, work area, scratch area, page navigation 

pane, scroll bars, and view controls 

 communicate causes and effects of an environmental problem 

 

Technical Skills: 

Operating Environment 

 open and close a program 

 save a publication 

 print a publication 

 open a saved publication 

 use the navigation pane to view pages in a publication 
 

Graphics 

About Objects 

 draw a shape 

 scale, move, rotate, or skew a shape 

 apply a style to a shape 

 fill a shape with a solid color, gradient, or texture 

 customize the color, weight, and dash style of an outline 

 change the shape of a drawn object 

 apply a shadow to an object 

 align objects relative to the margin guides 

About Pictures 

 insert a picture from a file 

 scale, move, rotate, or skew a shape 

 apply a picture style 

 customize the color, weight, and dash style of the picture border 

 crop a picture to fit inside a shape 

 add a caption to a picture 
 

Desktop Publishing 

 identify effective design elements on a sample postcard 

 format objects with color and design elements that suit the topic 

 format text to attract audience attention with a catchy title 

 format text so that it is easy to read 

 illustrate the environmental issue using appropriate pictures 

 format pictures attractively to draw the attention of the audience 

 insert a caption that explains the picture 

 arrange elements to create an appealing and balanced layout 
 

Word Processing 

 draw a text box 

 enter, select, and delete text in a text box 

 automatically resize text to fit the size of a text box 

 set the text direction to horizontal or vertical 

 format the font to set the typeface 

 adjust the font size 

 apply a style to text including bold, italics, or underline 

 set the case of text as normal, small caps, or all caps 

 set the spacing between characters as normal, loose, or tight 

 format the font color 

 align text within a text box 

 apply an effect to text such as a shadow, outline, engrave, or emboss 
 

Applied Technology 

 create a postcard about an environmental issue urging viewers to get involved 
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Assignment 5: About Microsoft Publisher 
 

 
 

What is Microsoft Publisher? 

Microsoft Publisher is a program that can be used to create publications such as cards, 

calendars, newsletters, awards, banners, advertisements, menus, and business cards. It has 

many features to design creative and professional looking publications, including: 

 Publications to be printed such as postcards, posters, pamphlets, and flyers 

 Publications for the Internet, such as email 

 Preset templates with the layout of objects already arranged 

 Color schemes that let you choose colors that look great together 

 Font schemes that have typefaces that complement one another 

 Background options such as textured, patterned, or colored fills 

 The ability to add pictures, clip art, shapes, tables, and WordArt 

 Predesigned elements called building blocks, which include headings, calendars, and 

borders  

 

 

Open Microsoft Publisher 

 Click the shortcut to Microsoft Publisher 

or click START – All Programs – Microsoft Office – Microsoft Publisher. 

 Click Blank 8.5 x 11”. 

 
  

You will be using Microsoft Publisher to make a 

postcard. Explore the program before you start. 
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Label the Parts of the Publisher Window 

 Read the descriptions of the parts of the Publisher window.  

 

 Ribbon: A band with a set of tabs located at the top of the application window. The 

tabs are File, Home, Insert, Page Design, Mailings, Review, and View.  

 

 Group: A collection of commands on a tab that do similar actions; for example, the 

font group has commands that format text. 

 

 Command: A button, box, or menu that tells the computer what to do; for example, 

the clip art command opens a searchable gallery of drawings, photographs, videos, 

and sounds that can be inserted into the document.  

 

 Work Area: The publication page onto which text and objects are placed. Guides, 

such as margins, can be viewed or hidden.  

 

 Page Navigation Pane: Displays thumbnails of the pages in the current publication, 

which can be collapsed to save space, or expanded to navigate quickly through 

multiple page documents. 

 

 Scratch Area: The grey region located outside the page boundaries, used to place 

objects partially on the publication or to keep objects that are going to be used at 

another time. 

 

 Title Bar: The top of the window containing the Publication Name, Program, and 

Window Controls. 

 

 Window Controls: Buttons to minimize, maximize or restore down the window, and to 

close the program. 

 

 Ruler: Horizontal measurements used to change tab settings, margins, and 

paragraph settings, and vertical measurements used to place text and objects. 

 

 Quick Access Toolbar: A customizable toolbar above the ribbon which holds 

commands used most often. 

 

 Scroll Bars: Vertical and horizontal scroll bars which can be dragged to change the 

view in the publication window. 

 

 View Controls: Options to view the publication in different levels of magnification, 

including a zoom level indicator and slider. 
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 Label the parts of the Microsoft Publisher window. 

 

 

 
 

 

 

 

1 Quick Access Toolbar  5 Page Navigation Pane  9 Scroll Bars 

2 Title Bar  6 Group  10 Scratch Area 

3 Window Controls  7 Command  11 Work Area 

4 Ribbon  8 Ruler  12 View Controls 

 

  

TIP: For many parts of the window, such as 

a command, you can rest the mouse 

pointer over it to make the name of the 

tool appear. 
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Explore the Ribbon 

 Click the Home tab of the ribbon. 

1. In which group can a command be found to underline text? 

 Font group 

 

2. You would like to place a heading in the center of the page. Which group has the 

command to center text? 

 Paragraph group 

 

3.  List the names of the four commands in the Clipboard group.  

 Paste, Cut, Copy, Format Painter 

 

 

 Click the other tabs of the ribbon to explore the program. 

4. In which tab do you find a command to put a picture in the publication? 

 Insert tab 

 

5. In which tab do you find preset color schemes to add a professional look to a 

publication? 

 Page Design tab 

 

6. Look at the tools on the Review tab. Which one do you think you might use the most? 

 Spelling, Research, Thesaurus, Translate Selected Text, or Language 

 

7. Click the View tab. Remove the check from Rulers and Page Navigation to see what 

happens. Why might someone want to view the publication with these elements not 

visible?  

 The publication in the work area can use a larger part of the screen. 

 

Close Microsoft Publisher 

 Click the Close button at the top right corner of the window. 

 If you are asked to save the changes, choose Don’t Save. 

If the window shows only the command icons, 

you can find the names of the commands by 

resting the mouse pointer over the icons. 
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Assignment 6: Design the Front of the Postcard 
 

 

View Sample Postcard 

 Open the Environment folder. (Ask your teacher where this is located.) 

 Double click postcard sample.  

   
Front of postcard   Back of postcard 

 To change from the front to the back of the postcard, click on the thumbnail in the Page 

Navigation Pane.  

1. What words on the front of the postcard will grab the viewer’s attention? 

 Destructive, damages, acid rain 

 

 

2. Why did the postcard designer choose to show a picture of a forest with dead trees? 

 The designer wanted to show the viewer how harmful acid rain is to trees. 

 

 

3.  How is the background of the shape related to the topic?  

 The background is rain. It shows clear rain and makes the viewer think about acid rain. 

 

 

4. List two facts the author wrote on the back of the postcard. 

 

Acid rain damages forests, lakes, and buildings. 

Acid rain has high amounts of nitric and sulphuric acid. 
 

 Click the Close button to close the postcard sample.  

Create a postcard to spread the news about an environmental 

issue. Once people know the importance of conserving Earth’s 

natural resources, they will be more likely to take action to help. 
 

The front of a postcard has an attention grabbing picture, with 

a caption to catch the viewer’s eye. There is a brief statement, 

or call to action, about the environmental problem. 

Text Box 

Shape with a fill 

Picture with a 

caption 

Environmental 

message  

Address of 

recipient  
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Open the Postcard Template 

 Open the Environment folder. (Ask your teacher where this is located.) 

 Double click postcard template. 

 
 

 

Draw a Shape to Act as the Background of the Postcard 

  Click the Home tab. From the Objects group, click, click Shapes. 

 Select an option from the gallery. 

 Click and drag on the work area to draw the shape.  

 

Scale, Move, Rotate or Skew the Shape 

 Click on the shape to select it, if necessary. 

 Move the mouse pointer over a corner handle until it turns into a two way arrow. 

Drag the corner handle inwards to make the shape smaller or outwards to make 

the picture larger.  

 If the shape needs to be put in a different place, move the mouse pointer over 

the center until it becomes a four way arrow. Drag the shape to a new place. 

 Some shapes have adjustment handles.  

 

 
 

 If available, drag the adjustment handles to change the shape. 

 

 

  

Front of postcard will contain: 

 Shape with a fill 

 Text Box 

 Picture with a caption 

 

Back of postcard will contain: 

 Environmental message  

 Address of recipient  

Drag a yellow diamond to change 

the shape. 

Drag a green circle to rotate 

the shape. 
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Format the Shape using Commands on the Drawing Tools Format Tab 

 
 

Select a Style 

 Click the Drawing Tools Format tab and locate the Shape Styles group. 

 Click the More arrow to view the Shape Styles gallery. 

 

 Click on a style to select it. 

 

Fill the Shape 

 From the Shape Styles group, click Shape Fill. 

 Select a color from the palette. 

 Click Shape Fill again and select Gradient. Select an option. 

 Click Shape Fill again and select Texture. Select an option. 

 Choose a fill for the shape.  

 

Select an Outline 

 Click Shape Outline. 

 Select a color from the palette. 

  Click Shape Outline again and select Weight. Select a line thickness. 

 Click Shape Outline again and select Dashes. Select a line style. 

 Choose an outline for the shape. 

A new tab appears on the ribbon – Drawing 

Tools Format tab. It contains commands to 

change the shape and make it look great.  

More arrow 

Consider the environmental topic that 

you chose. The style decisions you 

make should fit the issue.  
 

For example, if the postcard is about 

reforestation, green would be a 

suitable color. 
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Change the Shape 

 Click Change Shape. 

 Select a shape from the gallery. 

 

Apply a Shadow 

 From the Shadow Effects group, click Shadow Effects. 

 Choose a shadow style for the shape. 

 

Align the Shape 

 With the shape still selected, locate the Arrange group on the Drawing Tools Format tab. 

 Click Align. 

 If necessary, click Relative to Margin Guides. Click Align again. 

 Select Align Center. 

 Click Align again and select Align Middle.  

 

 Use your skills to format the shape: 

 
 

 

Draw a Text Box that Includes a Title about the Environmental Issue 

 Click the Home tab. From the Objects group, click Draw Text Box. 

 Click and drag on the postcard to make a rectangle. 

 Type a short phrase that will grab the viewer’s attention; for example: 

o Did you know that our forests are dying?  

o Save the polar bears. 

o Litter stinks! 
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Format the Text using Commands on the Text Box Tools Format Tab 

 
 

Adjust the Fit and Direction 

 With the text box still selected, click Text Fit from the Text Box Tools Format tab. 

 Select Best Fit to quickly adjust the font size of the text to fit the text box. 

 Click Text Direction to align the text vertically. 

 Click Text Direction again to align the text horizontally. 

Format the Font 

 

 

 Triple click the words or click and drag across the words to select all the text. 

 Click each of the commands to view the effect on the postcard. 

 Change the font to set the typeface of the letters. 

 Select the font size from a list of options. 

 Increase the font size to make the letters larger. 

 Decrease the font size to make the letters smaller. 

 Apply a bold style to make the letters look darker. 

 Apply an italic style to make the letters slant to the right. 

 Apply an underline style to place a line below the letters. 

 Select Normal, Small Caps, or All Caps to change the case of the letters. 

 Select Normal, Loose, or Tight to change the spacing between the letters. 

 
Select a font color from a palette. 

 

 Use your skills to make the text look great! 

Another new contextual tab appears on the ribbon – 

Text Box Tools Format tab. Use the commands on this 

tab to make the words attract attention. 

The Font group on the Text Box Tools Format 

tab has tools to make the words stand out.  

 

Explore and try each of the commands. 

Then choose options to make the postcard 

capture the reader’s attention. 

Tip: When choosing a font, hold the 

mouse pointer over a selection and 

see a preview on the postcard. You 

do not have to click on each font. 
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Align the Text 

 With the text still selected, locate the Alignment group on the Text Box Tools Format tab. 

 Click each of the nine alignment options to view the results. 

   
Align Top Left Align Top Center Align Top Right 

   

   
Align Center Left Align Center Align Center Right 

   

   
Align Bottom Left Align Bottom Center Align Bottom Right 

 

 Use your skills to align the words. 

Add Effects to Text 

 With the text still selected, locate the Effects group. 

 Experiment with each of the effects.  

    
Shadow Outline Engrave Emboss 

 Choose an effect to apply to the text on the postcard. 

 

Use your Skills to Make the Text Box Look Great 

 Apply the skills you have learned to make the text box look great using the Text Box Tools 

Format and Drawing Tools Format tabs. 

HINTS AND TIPS 
 

 If the shape behind the text box is dark you might want to 

make the text box white. 

 Change the shape of the text box. 

 Apply an outline that makes the text box stand out. 

 

 

Insert a Picture of the Environmental Issue that will Attract Attention 

 Click the Home tab. From the Objects group, click Insert Picture. 

 Go to your student folder where you saved your pictures. 

 Select a picture that will grab attention. Click Insert. 
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Resize and Move the Picture 

 Click on the picture to select it, if necessary. 

 Move the mouse pointer over a corner handle until it turns into a two way arrow. 

Drag the corner handle inwards to make the picture smaller or outwards to make 

the picture larger.  

 If the picture needs to be put in a different place, move the mouse pointer over 

the center until it becomes a four way arrow. Drag the picture into place. 

 
 

Format the Picture using Commands on the Picture Tools Format Tab 

 

 
 

Select a Style 

 Find the Picture Styles group on the Picture Tools Format tab and click the More arrow. 

 

 Hold the mouse pointer over a style to see a preview on the postcard. Click on the style 

you like. 

 

Change the Border 

 Click Picture Border. 

 Select a border using the Color, Weight, and Dashes options. 

 

Change the Shape 

 Click Picture Shape.  

 Change the shape. 

Another new contextual tab appears – the Picture Tools 

Format tab. Use the commands on this tab to format 

the picture you added to the postcard. 

More arrow 

Tip: If you don’t like a change you 

have made, click Undo on the Quick 

Access Toolbar. 
 

You may have to click Undo more 

than once. 

Resize the picture 

with a two way 

arrow on a corner 

handle. 

Move the picture 

with a four way 

arrow on the picture. 
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Add a Caption 

 Click Caption.  

 Rest the mouse pointer over a caption style in the gallery  

to preview it on the postcard. 

 Click on the caption style you like. 

 Click in the caption area on the postcard and type a short 

sentence explaining the environmental problem; for example: 

o Acid rain damages forests. 

o Global warming is destroying the habitat of polar bears. 

 

Complete the Postcard 

Use your skills and the commands on Text Box Tools 

Format tab, Drawing Tools Format tab, and Picture Tools 

Format tab to make the postcard look great. 

 

HINTS AND TIPS 
 

 Select a font that it is easy to read. 

 Format the text so that the title attracts 

attention. 

 Arrange the shape, text box, and picture on the postcard to create a balanced 

layout. 

 The text box with the title needs to stand out on the postcard and should not blend 

into the background shape.  

 You may want to change the color of the text box or caption box to white and the 

font color to black to make the words easy to read. 

 If you want to use a dark color for the text box or caption box you should change the 

font color of the letters to white to make them easier to read. 

 Change the shape of the caption box to attract attention to the information. 

 Apply an outline to the text box or caption box to make them stand out against the 

background. 

 Select colors and design elements that suit the topic. For example, green is suitable 

for forests and blue is suitable for water. 

 

Save the Postcard and Exit Microsoft Publisher 

 Click Save on the Quick Access Toolbar. 

 Go to the location where you save your work. Name the publication postcard. 

 Click Save. 

 Click the Close button at the top right corner of the window. 
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Assignment 7: Design the Back of the Postcard 
 

To complete the postcard, a written message and an address 

are needed. On the left side of the postcard you will explain the 

environmental issue to encourage others to get involved. On 

the right side you will write the address of the recipient. 

 

Who is reading your postcard? 

 

 Staff at your school (Dear TechnoSchool Staff) 

 Students at your school (Dear TechnoSchool Students) 

 Another student in your class 

 Another student in the school in another class 

 Teacher 

 Parent or family member 

 A student in another school 

 A fictional person 

 

Open the Postcard in Microsoft Publisher 

 Go to the location where you save your work. (Ask your teacher where this is located.) 

 Double click on postcard. The postcard opens in Microsoft Publisher. 

 

Move to Page 2 Using Page Navigation 

 In the Page Navigation pane, click on the back of the postcard to move to page 2. 

 
 

Draw a Text Box 

 Click the Home tab. From the Objects group, click Draw Text Box. 

 Draw a text box on the left side of the postcard.  

 

 

Get the research sheet you made in Session 1. You will refer to the Causes 

and Effects sections to get facts for the message on the postcard. 

A postcard usually has a 

written message on the 

left. To publicise your 

selected environmental 

issue, you will describe the 

problem and urge people 

to get involved. 

An address will be 

placed on the right half 

of the back of the 

postcard. 
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Write the Postcard Message 

 Type Dear Name, 

 Write a short paragraph with four sentences: 

o Write an introductory sentence that tells why you are sending the postcard. For 

example: 

 I wanted to write you to ask for your help. 

 I am worried about the health of our forests. 

 I like polar bears and I am worried about my favorite animals. 

 The playground is messy from litter. 

o Write a question that makes people think about the problems caused by the 

environmental issue. Use the facts in the Effects section of the research sheet. For 

example: 

 Did you know… 

 Can you believe… 

 Does it surprise you that… 

o Describe the environmental issue. KEEP your description SIMPLE. 

Use the information in the Causes section of the research sheet.  

o Write a concluding sentence that connects the person to the problem, 

encourages them to get involved or take action. For example: 

 I thought you might like to know about this problem because you like to 

hike in the forests. 

 I think we should schedule a cleanup day for our playground. 

 Are you ready to help? 

 Press ENTER. 

 Type Student Name. 

 Use your skills and the commands on the Drawing Tools Format tab and Text Box Tools 

Format tab to make the message look great. 

 
  

Microsoft Publisher automatically puts a 

hyphen between syllables in words. To 

remove the hyphen, click Hyphenation 

on the Text Box Tools Format tab. 



TECHNOENVIRONMENT  SESSION 2 

 

TECHNOKIDS INC.  2-19 

Add Address 

 

 Draw a text box below the stamp on the right side of the postcard. 

 Add actual or fictional address information: 

o Name 

o Street Address 

o City, Province/State, Country 

o Postal/Zip Code 

 Use your skills to format the text. 

 

Complete the Postcard Checklist 

 
Front of the Postcard  Back of the Postcard 

 shape draws attention to the issue   Message contains: 

 shape is formatted to suit the topic   o introductory sentence 

 text box displays short phrase about the problem   o question about effects of environmental  issue 

 text is formatted attractively and is easy to read   o description of environmental issue 

 picture illustrates the environmental issue   o call to action sentence 

 caption explains the picture   
Address contains: name, street address, city, 

province/state, country, and postal/zip code 

 

Postcard 

 all elements have been arranged to create a balanced, appealing layout 

 color and design choices are relevant to the topic 

 text is free of spelling and grammar errors  

You can address the postcard to: 

 School address 

 Home address 

 Another school address 

 Fictional address 

Before you send your postcard you need to make sure that it is 

complete. Use the checklist as a guide. 
 

Place a checkmark in each item of the checklist if it is finished.  

If it is not, then you will need to edit the content of your postcard.  
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Print the Postcard 

 Click the File tab. Click Print.  

 Under Settings, click the arrow below Pages and select Side-fold, half sheet. 

 
 

 Click the Print button.  

 

Assemble the Postcards 

 Cut the two postcards apart. 

 

 Fold each card so that the blank sides are together. Glue or tape the blank sides 

together to make a postcard. 

 
 

 

Save the Postcard and Exit Microsoft Publisher 

 Click Save on the Quick Access Toolbar. 

 Click the Close button at the top right corner of the window.   

 

Fold and glue or tape the empty 

sides together. You will have 2 two 

sided cards. 

Each postcard will have the 

title and picture on the front 

and the message and 

address on the back. 
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Session 2 Review: About Microsoft Publisher 
 

Number the parts of the Microsoft Publisher. 

 

 
 

1. Work Area 3. Page Navigation Pane  5. Group  

2. Quick Access Toolbar 4. Ribbon 6. View Controls 

/6 

 

 

Fill the blanks with the correct term. 

 

7. The band at the top of the window which holds a set of tabs is called the  ribbon . 

 

 

8. A   command is a tool on a tab that completes a task.  

 

 

9. The tab is divided into separate  groups . 

 

 

10. Text describing the contents of a picture is called a caption . 

 

/4 

2 

1 

3 

4 

5 

6 
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Select the command to complete the task. 

 

11. Draw a shape. 

 a. 
 

b. 
 

c. 
 

 

   

   

12. Fill a shape with a color. 

 a. 
 

b. 
 

c. 
 

 

   

   

13. Align a shape. 

 a. 
 

b. 
 

c. 
 

 

   

   

14. Draw a text box. 

 a. 
 

b. 
 

c. 
 

 

   

   

15. Choose an outline for a shape. 

 a. 
 

b. 
 

c. 
 

 

   

   

16. Add a picture to a publication. 

 a.  b.  c.   

   

/6 

 

 

Match the command to its function. 

 

17. D 
 

 A. Make the font smaller 

      

18. C 
 

 B. Make the words fit as large as possible in the text box 

      

19. B 
 

 C. Align text in the center of a text box. 

      

20. A 
 

 D. Add a caption to a picture 

      

/4 

 

 

Total: /20 
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Session 2 Skill Review: The World is Not Your Trash Can! 
 

Read the information and then follow the instructions on the next page to create a postcard. 

 

 

What is Garbage? 

Garbage is any item that is 

worthless and is no longer wanted 

or needed. Garbage can include 

food scraps, broken toys, 

electronics, clothes, pet litter, 

paper, and gardening debris. In 

many households, garbage is 

placed at the curb and picked up 

by a truck that transports it to a 

landfill site or transfer station. 

Harmful Effects 

 Greenhouse Gas: When garbage decomposes it produces 

methane and carbon dioxide. These greenhouse gases trap heat 

from the sun, causing the Earth to warm beyond its ideal 

temperature. Global warming alters weather patterns and climate, 

resulting in higher ocean temperatures, melting glaciers, rising sea 

levels, droughts, and floods.  

 Gas Explosions: Methane gas produced from decomposing 

garbage can migrate underground from the landfill into buildings 

through cracks or drainage pipes. This can cause an explosion. 

 Odor: Decomposing garbage can create an odor that is offensive 

to people living near the waste disposal site. 

 Contaminate Groundwater: Landfill sites are supposed to have a 

protective bottom layer to prevent contaminates from getting into 

groundwater. However, if there is no layer or it is cracked 

contaminates can leach into water from car batteries, paint, and 

household cleaners. 

Interesting Facts 

 Garbage is often called 

trash, litter, junk, waste, 

refuse, or rubbish. 

 The average person 

creates over 2000 

pounds of garbage 

each year. 

 It takes 95% less energy 

to recycle one 

aluminum can than to 

make a new can. 

 Five plastic soda bottles 

yield enough fiber for 

one extra-large T-shirt or 

one square foot of 

carpet. 

 Glass can be recycled 

an indefinite number of 

times. 

 Methane gas from 

landfills can be 

captured and used to 

fuel power plants, 

factories, and homes. 

 I million tons of waste 

can produce enough 

energy to power 700 

homes for a year. 

Garbage decomposing at landfill sites produces 
methane gas, which contributes to global warming. 

  

Solutions 

 Recycle: Recycle items such as paper, metal, and 

plastic. The materials used to create the items are 

transformed into new products. 

 Reduce: Purchase items that use less packaging or 

avoid items that will break easily or are just a fad. 

 Reuse: Donate, repair, or re-purpose an item to 

extend its use. 

 Compost: Place food scraps, grass clippings, weeds, 

and branches into backyard composter or Green 

Bin. 

 Landfill Gas Energy: Transform the gas produced by 

the garbage decomposing into energy. Wells are 

drilled into the waste with piping that transports the 

gas into a system that converts it into heat and/or 

electricity. 

 Regulations: Establish and enforce laws that control 

landfill gas emissions, restrict limits on household 

waste, and promote recycling. 

Landfill Gas Energy 
An examination of a solution that transforms 

garbage into energy for homes and factories. 

Advantages Disadvantages 

Reduce emissions of 

greenhouse gases 

that contribute to 

climate change. 

 

Renewable energy 

source. 

 

Reduce odor from the 

garbage 

decomposing. 

 

Generate revenue 

from garbage. 

Some landfill gas 

energy systems 

produce toxins that 

contribute to smog 

and acid rain. 

 

Not an effective 

solution for smaller or 

older landfill sites. 

 

Production and 

maintenance costs. 
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1. Double click postcard template in the Environment folder. 

  

2. a. On the front of the postcard, click Shapes.  

 b. Click and drag in the work area to draw a shape. 

  

3. Use your skills to format the shape: select a style , fill the shape , choose an  

 outline , apply a shadow , and align the shape in the center.  

  

4. Click Draw Text Box . Click and drag on the postcard to make a rectangle. 

  

5. Type a short phrase describing the garbage issue – Too Much Garbage!, Make Less  

 Waste, Stop the Litter Crisis. 

  

6. Use your skills to format the words: fit the text , change the direction , format  

 the font , align the text , and add effects.  

  

7. a. Insert a picture.  Go to the Environment folder and open the Garbage folder. 

 b. Choose a picture. Resize and move the picture to fit on the postcard. 

  

8. Use your skills to format the picture: select a style  and change the border.  

  

9. a. Add a caption to the picture.  Use information from the fact sheet.  

 b. Format the caption. 

  

10. In the Page Navigation pane, click page 2 to move to the back of the postcard. 

  

11. Draw a text box on the left side of the postcard.   

  

12. a. Use the fact sheet to write a message about the environmental issue. 

 b. Describe the problem using the Effects section. Urge people to help. 

 c. Sign your name. 

  

13. Format the text to make it look good. 

  

14. Draw a text box   on the right side of the postcard. Write an address. 

  

15. Print the postcard. Choose Side-fold, half sheet. Cut the 2 cards apart and tape. 

  

16. a. Save the postcard as garbage. 

 b. Close Microsoft Publisher. 
 

Send a postcard 

to spread news 

about the 

problem with 

garbage. 
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Session 2 Extension Activity: Environmental Map 
 

Maps can be used to present information clearly. Together with 

pictures, they are a powerful way to spread an environmental 

alert. 
 

Use Microsoft Publisher to display a map and a picture with a 

caption. Together these elements can communicate a 

message with impact. 

 

1. Use the Internet to find a map of a location where the environmental issue exists. 

  

2. Locate a picture of the environmental issue in this area. Try to find a ‘shocking’ picture 

to draw attention to the problem. 

  

3. Open Microsoft Publisher and select Blank 8.5 x 11”. 

  

4. At the TOP of the page, insert a picture of the map: 

 a. Click Insert Picture on the Home tab.   Select the map. Click Insert. 

 b. Resize  and move the picture . 

 c. Use tools on the Picture Tools Format tab to format the picture. 

  

5. Insert the shocking picture of the environmental issue. Place it below the map. Use 

your skills to format the picture. 

  

6. Insert a caption that describes the environmental issue: 

 a. From the Picture Tools Format tab click Caption. 
 

 b. Select a style you like. 

 c. Type a sentence about the environmental issue. 

  

7. Use a shape to show the location of the issue: 

 a. From the Home tab click Shapes. 
 

 b. Select a STAR. Draw the shape onto the map.  

 c. Use tools on the Drawing Tools Format tab to format the STAR. 

  

8. Use Shapes to draw a line from the STAR to the picture/caption.  
 

  

9. Insert a text box: 

 a. From the Home tab Draw Text Box. 
 

 b. Type Student Name. 

 c. Use tools on the Text Box Tools Format tab to make the words look great. 

  

10. Save your work as map. Close Microsoft Publisher. 

 




